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RESUMO 

 

Fibroblastos, colágeno e o Fator de crescimento transformante beta (TGF-β) são componentes 

importantes no Granuloma Piogênico (GP) e no Fibroma Ossificante Periférico (FOP), 

executando funções diferentes nessas lesões. O objetivo desse estudo foi avaliar o papel do 

colágeno e da imunomodulação pelo Fator de crescimento transformante beta (TGF-β) nos 

achados clínicos e microscópicos de GP e FOP. 

GP (n=20) e FOP (n=20) foram selecionados para avaliação clínica (sexo, idade, localização, 

tamanho e tempo de evolução) e análise microscópica (coloração através de Picrosirius Red 

para análise do colágeno através de luz polarizada e imunoistoquímica para TGF-β) realizadas 

em áreas superficiais e profundas das duas lesões. ANOVA/Bonferroni e teste-t, correlação de 

Pearson e χ
2 

 foram utilizados para comparar e correlacionar os parâmetros analisados. 

(p<0.05, GraphPad Prism 5.0). 

A profundidade do GP apresentou uma maior quantidade de colágeno em relação a sua 

superfície (p<0,001), e sua superfície mostrou uma menor quantidade de colágeno tipo I 

(birrefringência amarelo-avermelhada) quando comparados a sua profundidade, superfície e 

profundidade do FOP (p<0,001). O número de células positivas para TGF-β foi menor na 

superfície do GP quando comparado com a sua profundidade e com superfície e profundidade 

do FOP (p<0,001). Sexo e localização não afetaram esses parâmetros, mas o perfil de 

colágeno e a imunomarcação para TGF-β foram modificados pelo tempo de evolução e pelo 

tamanho das lesões. Embora GP e FOP sejam lesões gengivais reativas, a expressão de TGF-β 

e o papel do colágeno evidenciaram comportamentos biológicos diferentes nessas lesões, 

sugerindo origens biológicas diferentes para seus componentes. 

Palavras-chave: Granuloma Piogênico. Fibroma Ossificante Periférico. Colágeno. Fator de 

Crescimento Transformante Beta.  



 

 

ABSTRACT 

 

Background: Collagen is a component of Pyogenic Granuloma (PG) and Peripheral 

Ossifying Fibroma (POF) and performs different functions in these lesions. The objective of 

this study is to evaluate the role of collagen and immunostaining for Transforming Growth 

Factor beta (TGF-β) in the clinical and microscopic findings of PG and POF. 

Methods: PG (n=20) and POF (n=20) were selected for clinical evaluation (sex, age, 

localization, size and evolution time) and microscopic analysis (picrosirius red staining for 

collagen analysis and immunohistochemistry for TGF-β) performed in the superficial and 

deep areas of the two lesions. ANOVA/Bonferroni and t-test, Pearson correlation and χ2 were 

used to compare the sites and parameters analyzed (p<0.05, GraphPad Prism 5.0). 

Results: The depth of PG presented the highest amount of collagen (p<0.001), and its surface 

showed the lowest amount of type 1 collagen (yellow-red strong birefringence). Type 1 

collagen gradually increased in depth of PG, surface and depth of POF (p<0.001). The number 

of TGF-β+ cells was lower on the surface of PG compared with the depth of PG and the two 

areas of POF (p<0.001). Sex and localization did not affect these parameters, but the profile 

of collagen and immunostaining for TGF-β suffered from modifications by the time of 

evolution and the size of the lesion. 

Conclusions: Although PG and POF are reactive gingival lesions, the expression of TGF-β 

and its role in collagen showed different biological behaviors in these lesions, suggesting 

different biological origins for its components. 

Keywords: Pyogenic Granuloma, Peripheral Ossifying Fibroma, Collagen, Transforming 

Growth Factor beta. 
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1 INTRODUÇÃO 

 

A proximidade da gengiva com a mucosa alveolar, ligamento periodontal, dente e 

osso alveolar propicia que esse sítio anatômico tenha um maior risco para o desenvolvimento 

de lesões específicas e inespecíficas. Esse atributo confere uma maior dificuldade na 

compreensão de lesões gengivais.
1
 Levantamentos epidemiológicos de lesões gengivais são 

frequentemente executados,
2-4

 porém as metodologias empregadas concentram-se em 

documentos e registros médicos, tornando-se difícil criar hipóteses para os mecanismos de 

patogênese das diferentes lesões. 

As lesões mais frequentes em gengiva são reativas, e, apesar das pequenas 

variações, o Granuloma Piogênico (GP) e o Fibroma Ossificante Periférico (FOP) são os mais 

comuns.
1,4-6 

Essas duas lesões apresentam caráter não-neoplásico, possuem crescimento 

nodular, podem atingir grandes tamanhos e são causadas por traumas crônicos e baixa 

intensidade, doença periodontal e biofilme dental.
1,7-9

 

No entanto, enquanto o GP exibe sangramento frequente,
10

 o FOP apresenta uma 

profundidade dura e crepitante.
11

 O GP apresenta uma intensa proliferação vascular e 

inflamação crônica,
4
 enquanto o FOP caracteriza-se pela proliferação de fibroblastos 

associado a um material mineralizado (osso, material cementoide ou calcificação 

distrófica).
12,13

 Além disso, o GP pode ser encontrado em outras localidades orais,
14

 já o FOP 

localiza-se exclusivamente na gengiva.
11

 

Propõe-se que GP e FOP tenham origens celulares distintas,
11

 e o papel do 

colágeno e de citocinas envolvidas no desenvolvimento e maturação dessas lesões podem 

ajudar a explicar essa teoria. O TGF-β é uma citocina que está fortemente associada à 

produção e maturação do colágeno,
15

 que é um importante componente nas duas lesões. A 

superprodução de TGF-β pode levar a um crescimento tecidual,
16

 proliferação vascular,
17 

formação óssea e colagênese,
18

 o que tem sido demonstrado tanto em GP como em FOP.
13

  

TGF-β é um importante bioestimulador da síntese de colágeno, mas sua atividade 

é modificada na presença de inflamação (presente no GP).
19

 No entanto, a maturação de GP 

ocorre paralelamente a uma diminuição da inflamação,
1
 que é necessária para a maturação 

óssea,
18

 sustentando o fato de que GP não evolui para um FOP. 

Vale ressaltar que existem poucos estudos na literatura que buscam correlacionar o 

papel do colágeno e da imunomarcação para TGF-β com os parâmetros clínicos e 

microscópicos de GP e FOP. 

A compreensão do papel do TGF-β no perfil de colágeno dessas duas lesões pode 
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auxiliar no entendimento de suas etiopatogenias. Assim, o objetivo desse estudo foi avaliar o 

papel do colágeno e da imunomarcação para TGF-β nos achados clínicos e microscópicos de 

GP e FOP.   
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2 MATERIAIS E MÉTODOS 

 

2.1 Considerações éticas 

 

Essa pesquisa foi aprovada pelo Comitê de Ética em Pesquisa Humana da 

Universidade Federal do Ceará (protocolo nº 1.799.024). 

 

2.2 Cálculo amostral 

                  

Baseado na diferença de prevalência de sangramento entre GP (92,74%) e FOP 

(39,91%) observado em estudo epidemiológico de lesões gengivais por Zhang,
7
 foi necessária 

uma amostra de 20 casos por grupo (α = 0,05; β = 0,10) (método de Fleiss com correção de 

continuidade).  

 

2.3 Tipo de estudo e caracterização das amostras 

 

Trata-se de um estudo retrospectivo, quantitativo e transversal, na qual foram 

selecionados 20 casos de GP e 20 casos de FOP do laboratório de Patologia Bucal da 

Universidade Federal do Ceará, sendo todos os pacientes diagnosticados e tratados no mesmo 

centro odontológico. Os relatos histopatológicos continham informações clínicas de sexo, 

idade, localização, tamanho e tempo de evolução. As lâminas histológicas foram analisadas 

descritivamente, e os blocos de parafina apresentavam material com quantidade e qualidade 

adequadas para análise histológica. Pacientes com GP extra-gengival, com mais de uma lesão 

de GP ou FOP, espécimes de gestantes e pacientes diagnosticados com outras lesões ou 

condições sistêmicas foram excluídos. FOPs ulcerados também foram excluídos.  

 

2.4 Análise histoquímica  

 

Lâminas foram confeccionadas através de cortes de 3 µm dos blocos para 

coloração por Picrosirius Red para quantificação do colágeno. As amostras foram 

desparafinizadas, reidratadas e submetidas à coloração por Picrosirius Red (Scytech®) (30 

min). As amostras foram banhadas em ácido clorídrico (HCl) a 5% e contra-coradas com 

hematoxilina de Harris por 45 segundos, seguidas de desidratação, diafanização e montagem 

em Enthellam®. 
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Seis campos da superfície e seis campos da profundidade foram selecionados 

previamente de GP e FOP e fotografados utilizando um microscópio (DM2000, Leica®) 

acoplado a uma câmera (DFC295, Leica®), através de um software Leica Application Suite 

(LAS, Leica®), em um aumento de 200x para análise do colágeno. As fotomicrografias para 

análise do colágeno foram realizadas em luz convencional e polarizada.
31 

 

2.5 Análise imunoistoquímica  

 

Cortes de 3 µm das amostras foram colocadas em lâminas silanizadas e 

processadas. As amostras foram desparafinizadas, reidratadas e submetidas à recuperação 

antigênica utilizando um tampão de citrato (pH 6,0) em calor (95°C) por 30 minutos. Para 

bloqueio da peroxidase endógena, os espécimes foram incubados por 30 minutos com 

peróxido de hidrogênio (H2O2 – 3%) em solução tampão de fosfato (PBS), e, em seguida, 

incubados com anticorpo primário anti-TGF-β (1:400, Abcam®) overnight. Após lavagem em 

PBS, as amostras foram incubadas em anticorpo secundário Histofine (Nicherei®) por 60 

minutos, seguidas para revelação com o cromógeno diaminobenzidina (DAB) durante 5 

minutos e contra-coradas através de hematoxilina de Harris (10 segundos). Assim, as amostras 

foram desidratadas, diafanizadas e montadas em Enthellam®. Um nódulo linfático humano 

foi utilizado como controle positivo da reação. Como controle negativo, omitiu-se o anticorpo 

primário. 

Seis campos da superfície e seis campos da profundidade foram selecionados 

previamente de GP e FOP e fotografados utilizando um microscópio (DM2000, Leica®) 

acoplado a uma câmera (DFC295, Leica®), através de um software Leica Application Suite 

(LAS, Leica®), em um aumento de 400x (Área = 1.56 mm²) para quantificação das células 

positivas para TGF-β. 

 

2.6 Análise microscópica: análise da densidade óptica das fibras de colágeno 

 

As imagens obtidas de lâminas coradas por Picrosirius Red através de luz 

convencional foram analisadas utilizando o software ImageJ® (NIH Image) através do 

comando Color Threshold (Image > Adjust > Color Threshold) (RGB), onde foi realizada a 

calibração para as cores Vermelha (mínimo: 71, máximo: 255), Verde (mínimo: 0, máximo: 

69) e Azul (mínimo: 0, máximo: 92). Após calibração, as imagens foram convertidas em 
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escala de 8-bits (Image > Type > 8-bit), binarizadas (Process > Binary > Make Binary) e a 

área total de colágeno marcada em vermelho foi mensurada (Analyze > Analyze Particles).
31

 

 

  

2.7 Análise microscópica: análise da densidade óptica das fibras de colágeno em luz 

polarizada 

 

As imagens obtidas através de luz polarizada foram analisadas através do software 

ImageJ® (NIH Image) utilizando o mesmo comando citado anteriormente. As cores foram 

ajustadas através do comando Color Threshold (Image > Adjust > Color Threshold), na 

função RGB, para vermelho (mínimo: 0, máximo: 255), verde (mínimo: 0, máximo: 255) e 

azul (mínimo: 0, máximo: 32). Após a calibração, as imagens foram convertidas para a escala 

de 8-bit (Image > Type > 8-bit), binarizadas (Process > Binary > Make Binary), e a área total 

de colágeno foi medida (Analyze > Analyze Particles). Após ajuste, as imagens foram 

mensuradas através da porcentagem de área de colágeno marcada em amarelo-avermelhado 

(sugestiva de colágeno tipo I).  

A área de birrefringência amarelo-avermelhada (fibras de colágeno tipo I) foi 

subtraída da área vermelha (fibras colágenas totais) para obtenção da área de birrefringência 

esverdeada (fibras de colágeno tipo III).
31 

 

2.8 Análise microscópica: imunomarcação para TGF-β 

 

As imagens obtidas através de imunoistoquímica foram analisadas utilizando o 

software ImageJ® (NIH Image), pelo comando Cell Counter. Um operador treinado e 

calibrado quantificou as células positivas (marcação nuclear e citoplasmática) e negativas  

para TGF-β a fim de quantificar a porcentagem de células positivas. 

 

2.9 Análise estatística 

 

Dados quantitativos (média ± EP) foram analisados através do teste de 

Kolmogorov-Smirnov e comparados utilizando ANOVA/Bonferroni, teste-t e correlação de 

Pearson (dados paramétricos). Os dados categóricos clínicos (n, %) foram comparados 

utilizando χ
2 

 ou teste exato de Fisher. Utilizou-se o software Graph Pad Prism 5.0 (GraphPad 

Software, Inc., California, USA) com 95% de confiança (p<0,05). 



16 

 

 

3. RESULTADOS 

 

3.1 Caracterização da amostra 

 

Do total de 20 casos de GP, 13 eram mulheres (65%) e 7 eram homens (35%). Dos 

20 casos de FOP, 12 (60%) eram mulheres e 8 (40%) eram homens. Não houve diferença com 

relação a esses parâmetros (p=0.744) (Tabela 1). 

A maxila mostrou maior prevalência de GP (n=14, 70%), e foi estatisticamente 

diferente do FOP, que apresentou maior prevalência na mandíbula (n=13, 65%) (p=0.027). A 

região anterior apresentou maior prevalência de GP (n=14, 70%), que foi estatisticamente 

diferente para FOP, que demonstrou maior prevalência em região posterior (n=15, 75%) 

(p=0.004) (Tabela 1). 

A média de idade dos pacientes com GP foi de 35.4±3.8, o que foi 

estatisticamente semelhante ao FOP (29.9±3.4) (p=0.325), e a média do tempo de evolução 

foi semelhante nas duas lesões (7.1±2.9 meses e 8.7±3.0 meses, respectivamente) (p=0.705). 

No entanto, o tamanho médio do GP (1.5±0.2 cm) foi significativamente menor que o FOP 

(2.4±0.3 cm) (p=0.016) (Tabela 1). 

 

3.2 Caracterização microscópica de GP e FOP 

 

O GP evidenciou ulceração na porção superficial com infiltrado inflamatório 

misto constituídos por neutrófilos polimorfonucleares e células mononucleares 

(histiolinfoplasmocitário). Uma intensa proliferação vascular foi notada na profundidade das 

lesões.  

No FOP, observou-se a presença de um epitélio paraceratinizado, com um tecido 

conjuntivo denso com vasos sanguíneos maduros e raras células inflamatórias. Na 

profundidade do FOP, um grande número de células ovoides foram associadas com a presença 

de material mineralizado consistente com osso, material cementoide ou calcificação 

distrófica.  
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Tabela 1. Características clínicas dos casos de GP e FOP  

  Grupo   

  GP FOP p-Valor 

Sexo 

  

  

Feminino 13 (65%) 12 (60%) *0.744 

Masculino 7 (35%) 8 (40%)   

Presença nos ossos gnáticos 
  

  

Maxila 14 (70%) 7 (35%) *0.027 

Mandíbula 6 (30%) 13 (65%)   

Localização 
  

  

Anterior 14 (70%) 5 (25%) *0.004 

Posterior 6 (30%) 15 (75%)   

Idade (anos) 35.4±3.8 29.9±3.4 
†
0.325 

Tempo de evolução (meses) 7.1±2.9 8.7±3.0 
†
0.705 

Tamanho (cm) 1.5±0.2 2.4±0.3 †
0.016 

*qui-quadrado, dados expressos em frequência absoluta e percentual; 

†
test t; dados expressos em média ± EP. 

 

3.3 Perfil do colágeno em GP e FOP 

 

O colágeno total da área superficial de GP (3.1±0.7%) foi significativamente 

menor que a profundidade da mesma lesão (27.8±2.4%). Na profundidade de GP, observou-se 

a presença de uma maior quantidade de colágeno do que a superfície (5.4±1.2%) e 

profundidade do FOP (7.6±2.6%) (Figura 1).  

Da área total de colágeno, a superfície de GP (24.6±4.1%) apresentou menor área 

de birrefringência amarelo-avermelhado (colágeno tipo I) quando comparado à profundidade 

da mesma lesão (51.1±3.8%). Esses valores foram significativamente menores que a 

superfície (96.0±4.0%) e profundidade (95.7±3.3%) do FOP (p<0.001). Em contraste com a 

área total de colágeno, a superfície de GP (77.9±2.3%) apresentou maior área de 

birrefringência esverdeada (colágeno tipo III) em relação à sua profundidade (46.4±4.1%), 

superfície (4.0±3.6%) e profundidade (4.3±3.3%) do FOP (p<0.001) (Figura 1).  
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3.4 Imunomarcação para TGF-β em GP e FOP 

 

GP apresentou um menor número de células positivas para TGF-β em sua 

superfície (40.8±3.1%), sendo significativamente menor que a profundidade da mesma lesão 

(64.2±3.1%), superfície (60.9±8.3%) e profundidade (66.2±6.4%) do FOP (p=0.001) (Figura 

1). 

Figura 1. Perfil histológico, histoquímico e imunoistoquímico  em áreas superficiais 

e profundas dos casos de GP e FOP  

 

(Aumento: 200; H&E: Hematoxilina-eosina; IHC: Imunoistoquímica). A análise microscópica evidenciou 

intenso infiltrado inflamatório, pouco colágeno e imunomarcação para TGF-β na superfície de GP e baixa 

inflamação, intensa deposição de colágeno (tipo I) e imunomarcação para TGF-β na profundidade de GP. Na 

superfície e profundidade do FOP, baixa inflamação, níveis elevados de colágeno tipo I e imunomarcação para 

TGF-β foram mostrados. *p<0.05 versus superfície de GP; **p<0.05 versus profundidade de GP (média ± EP, 

ANOVA/Bonferroni).Fonte: Dados da pesquisa. 
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3.5 Correlação clínico-patológica e microscópica entre o perfil de colágeno e 

imunomarcação para TGF-β em diferentes áreas de GP e FOP 

 

Sexo e localização não influenciaram significativamente o perfil de colágeno e 

imunomarcação para TGF-β em GP e FOP (Tabela 2). No entanto, no GP, o tempo de 

evolução correlacionou-se diretamente com o colágeno do tipo I (birrefringência amarelo-

avermelhada) em profundidade (p=0.042, r=0.422) e inversamente correlacionado com o 

colágeno do tipo III (birrefringência esverdeada) na mesma região (p=0.018, r=–0.583). No 

FOP, o número de células positivas para TGF-β na superfície correlacionou-se diretamente 

com o tamanho da lesão (p=0.028, r=0.972), e a quantidade de células positivas para TGF-β 

na profundidade foi inversamente correlacionado com o tempo de evolução (p=0.019, r=–

0.887) (Tabela 3). 

No GP, o colágeno total na superfície correlacionou-se diretamente com o 

colágeno tipo III (birrefringência esverdeada) na superfície (p=0.001, r=0.598) e na 

profundidade (p<0.001, r=0.682) e inversamente com o colágeno tipo I (birrefringência 

amarelo-avermelhada) na superfície (p=0.001, r=–0.598) e na profundidade (p<0.001, r=–

0.682). Colágeno do tipo I e III correlacionaram-se inversamente em ambas as regiões (p < 

0,001, r = 1,000). Imunomarcação para TGF-β não evidenciou qualquer correlação com o 

perfil de colágeno em GP (Tabela 4). 

No FOP, o colágeno total na superfície mostrou uma correlação direta com o 

colágeno total em profundidade (p=0.027, r=0.633), e o tipo III (birrefringência esverdeada) e 

tipo I (birrefringência amarelo-avermelhada) correlacionaram-se inversamente com superfície 

e profundidade (p<0.001, r=-1.000). Imunomarcação para TGF-β mostrou correlação direta 

com o colágeno total na superfície (p=0.027, r=0.811), e a imunomarcação na profundidade 

de FOP foi diretamente correlacionada com o colágeno tipo I na superfície (p<0.001, r=1.000) 

e inversamente correlacionada com o colágeno tipo III na superfície (p<0.001, r=–1.000) 

(Tabela 4). 
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Tabela 2. Efeitos do sexo, presença nos ossos gnáticos e localização nos achados histológicos dos casos de GP e FOP. 

 Sexo  Presença nos ossos gnáticos  Localização 

 GP  FOP  GP  FOP  GP  FOP 

 Fem. Masc. p-

Valor 

 Fem. Masc. p-

Valor 

 Maxila Mandíbu

la 

p-

Valor 

 Maxila Mandíbu

la 

p-

Valor 

 Anterior Posterior p-

Valor 

 Anterior Posterior p-

Valor 

Colágeno Total 

superficial 

3.0±1.2 3.5±1.4 *0.813  7.4±2.2 3.8±0.9 *0.217  3.5±1.3 1.3±0.2 *0.375  6.5±2.3 5.2±1.9 *0.674  4.2±1.7 1.2±0.3 

*0.124 

 9.9±2.8 4.0±0.9 *0.165 

Colágeno Total  

profundo 

33.4±3.5 21.6±2.4 *0.056  11.5±4.0 2.8±1.4 *0.099  26.3±4.1 31.1±3.8 *0.573  7.0±3.2 8.1±4.4 *0.849  26.9±2.9 36.7±9.6 

*0.388 

 10.8±7.0 5.6±3.0 *0.457 

Colágeno Tipo 

I superficial 

28.6±7.3 20.5±1.6 *0.297  100.0±0.

0 

100.0±0.

0 

*0.407  19.7±1.4 18.8±4.7 *0.811  100.0±0.0 100.0±0.

0 

*1.000  17.8±1.3 20.3±5.6 

*0.521 

 100.0±0.

0 

100.0±0.

0 

*1.000 

Colágeno Tipo 

I profundo 

50.4±5.9 63.7±7.1 *0.162  92.2±7.7 100.0±0.

0 

*0.374  57.3±8.2 45.5±6.5 *0.444  90.3±9.6 100.0±0.

0 

*0.292  64.3±9.1 39.2±11.

1 *0.139 

 100.0±0.

0 

92.2±7.7 *0.482 

Colágeno Tipo 

III superficial 

77.2±4.6 79.4±1.6 *0.671  0.0±0.0 0.0±0.0 *1.000  80.2±1.4 81.1±4.7 *0.812  0.0±0.0 0.0±0.0 *1.000  82.2±1.3 79.6±5.6 

*0.521 

 0.0±0.0 0.0±0.0 *1.000 

Colágeno Tipo 

III profundo 

53.4±4.9 36.2±7.1 *0.056  7.7±7.7 0.0±0.0 *0.374  42.6±8.2 54.4±6.5 *0.445  9.6±9.6 0.0±0.0 *0.292  35.6±9.1 60.7±11.

1 *0.139 

 0.0±0.0 7.7±7.7 *0.482 

Células TGF-

β+  superficial 

37.7±6.5 48.2±3.4 *0.503  53.3±20.

7 

31.3±9.0 *0.386  35.2±6.8 42.1±8.2 *0.556  53.3±20.7 23.0±6.3 *0.347  40.0±6.4 35.2±12.

0 

*0.834  40.3±28.

1 

43.2±13.

6 

*0.919 

Células TGF-

β+  profundo 

70.3±8.6 60.7±2.3 *0.238  68.1±9.3 67.7±15.

8 

*0.980  64.5±2.9 69.5±15.

6 

*0.692  66.0±21.3 66.4±8.4 *0.987  64.8±8.4 70.0±10.

2 

*0.744  57.6±34.

0 

70.6±6.7 *0.769 

*Teste t; dados expressos em média ± EP. 
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Tabela 3. Efeitos da idade, Tempo de Evolução e Tamanho das lesões nos achados histológicos 

dos casos de GP e FOP. 

  
GP  FOP 

  
Idade 

Tempo 

de 

Evolução 

Tamanho  Idade 

Tempo 

de 

Evolução 

Tamanho 

Colágeno Total r 0.170 -0.017 0.278  -0.576 -0.258 -0.263 

Superficial p-Valor 0.416 0.950 0.407  0.104 0.622 0.668 

Colágeno Total r -0.130 -0.254 -0.595  -0.204 -0.227 -0.671 

Profundo p-Valor 0.536 0.325 0.054  0.599 0.666 0.215 

Colágeno Tipo I r 0.003 -0.145 0.475  0.000 0.000 0.000 

Superficial p-Valor 0.989 0.577 0.140  1.000 1.000 1.000 

Colágeno Tipo I r 0.195 0.422* 0.259  0.073 0.488 0.700 

Profundo p-Valor 0.350 0.042 0.441  0.852 0.326 0.188 

Colágeno Tipo III r -0.188 0.202 -0.475  0.000 0.000 0.000 

Superficial p-Valor 0.390 0.454 0.140  1.000 1.000 1.000 

Colágeno Tipo III r -0.271 -0.583
*
 -0.259  -0.073 -0.488 -0.700 

Profundo p-Valor 0.200 0.018 0.441  0.852 0.326 0.188 

Células TGF-β + r -0.048 0.521 -0.173  -0.024 -0.716 0.972
*
 

Superficial p-Valor 0.881 0.150 0.656  0.964 0.174 0.028 

Células TGF-β +  r -0.085 -0.318 0.090  0.194 -0.887
*
 -0.142 

Profundo p-Valor 0.793 0.404 0.832  0.592 0.019 0.761 

*p<0.05, Teste de correlação de Pearson. 
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Tabela 4. Correlação entre imunomarcação para TGF-β e perfil de colágeno nos casos de GP e FOP  

  

  

Colágeno 

Total 

Superficial 

Colágeno 

Total 

Profundo 

Colágeno 

Tipo I 

Superficial 

Colágeno 

Tipo I 

Profundo 

Colágeno 

Tipo III 

Superficial 

Colágeno 

Tipo III 

Profundo 

Células TGF-

β + 

Superficial 

Células 

TGF-β + 

Profundo 

GP 

         Colágeno Total  r - -0.325 -0.598* -0.682* 0.598* 0.682* 0.173 -0.321 

Superficial p-Valor - 0.091 0.001 <0.001 0.001 <0.001 0.554 0.264 

Colágeno Total  r - - -0.363 0.247 0.363 0.247 -0.397 0.403 

Profundo p-Valor - - 0.058 0.072 0.058 -0.072 0.160 0.153 

Colágeno Tipo I r - - - 0.298 -1.000* -0.298 0.227 0.208 

Superficial p-Valor - - - 0.124 <0.001 0.124 0.435 0.476 

Colágeno Tipo I r - - - - -0.298 -1.000* 0.062 -0.296 

Profundo p-Valor - - - - 0.124 <0.001 0.833 0.304 

Colágeno Tipo III r - - - - - 0.298 -0.227 -0.208 

Superficial p-Valor - - - - - 0.124 0.435 0.476 

Colágeno Tipo III r - - - - - - -0.062 0.296 

Profundo p-Valor - - - - - - 0.833 0.304 

Células TGF-β +  r - - - - - - - 0.524 

Superficial p-Valor - - - - - - - 0.066 

Células TGF-β +  r - - - - - - - - 

Profundo p-Valor - - - - - - - - 

FOP 

         Colágeno Total r - 0.633* -0.234 -0.142 0.234 0.142 0.126 -0.129 

Superficial p-Valor - 0.027 0.464 0.661 0.464 0.661 0.788 0.808 

Colágeno Total  r - - -0.374 -0.467 0.374 0.467 0.811* 0.509 

Profundo p-Valor - - 0.231 0.126 0.231 0.126 0.027 0.303 

Colágeno Tipo I r - - - 0.625* -1.000* -0.195 -0.451 1.000* 

Superficial p-Valor - - - 0.022 <0.001 0.543 0.310 <0.001 

Colágeno Tipo I r - - - - -0.195 -1.000* -0.669 -0.344 

Profundo p-Valor - - - - 0.543 <0.001 0.100 0.504 

Colágeno Tipo III r - - - - - 0.195 0.451 -1.000* 

Superficial p-Valor - - - - - 0.543 0.310 <0.001 

Colágeno Tipo III r - - - - - - 0.669 0.344 

Profundo p-Valor - - - - - - 0.100 0.504 

Células TGF-β +  r - - - - - - - 0.799* 

Superficial p-Valor - - - - - - - 0.031 

Células TGF-β +  r - - - - - - - - 

Profundo p-Valor - - - - - - - - 

*p<0.05, teste de correlação de Pearson.
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4. DISCUSSÃO 

 

GP e FOP são as duas lesões mais prevalentes no tecido gengival. Tem sido 

proposto que GP é causado por bactérias piogênicas e FOP tem uma origem neoplásica.
1
 

Atualmente é conhecido que GP e FOP são lesões reativas que estão fortemente associadas 

com biofilme dental.
3-4

 

No presente estudo, levantamentos epidemiológicos não mostraram diferenças 

significativas entre GP e FOP com relação à distribuição por idade e predileção por 

mulheres.
4-6

 A distribuição topográfica varia de acordo com o estudo, demonstrando que há 

mais casos de GP em maxila e região anterior
7
 e mais casos de FOP em mandíbula e região 

posterior,
21

 como evidenciado em nosso estudo, embora o oposto também tenha sido 

descrito.
6
  

Com relação ao tamanho e o tempo de evolução, enquanto Zhang e colaboradores
4
 

mostraram um tempo de evolução mais longo do GP em relação ao FOP, nosso estudo não 

mostrou diferença significativa. Além disso, embora Effiom e colaboradores
5
 não mostrarem 

nenhuma diferença no tamanho das duas lesões, Kfir e colaboradores
6
 demonstraram que FOP 

era significativamente maior do que GP (similar a nosso estudo).  

Em relação às características clínicas e microscópicas, GP exibe sangramento e é 

nodular, firme, eritematoso, ulcerado e densamente inflamado,
7
 enquanto FOP é uma lesão 

nodular e firme, com células fusiformes, alta celularidade, vascularização moderada e sem 

inflamação.
22

 Apesar dessas diferenças, apresentam um tecido conjuntivo abundante, porém, o 

FOP, demonstrando mineralização.
22-23

 

O colágeno total e o tipo I (forma madura das fibras colágenas) aumentou 

gradualmente da superfície para a profundidade em GP. A superfície de GP é intensamente 

inflamada (inflamação aguda) e isso aumenta a expressão de metaloproteinases de matriz 

(MMP). MMPs degradam o colágeno, reduzindo a sua quantidade.
24-25

 Além disso, a 

profundidade de GP apresenta alta imunomarcação para TGF-β, uma citocina que está 

fortemente associada com a produção e maturação de colágeno.
15 

No entanto, a profundidade 

de GP não mostra níveis de inflamação crônica elevados. Assim, isso pode explicar a 

superprodução e maturação do colágeno na profundidade de GP, que é comum em GPs 

antigos com suave inflamação.
1
 

No FOP, há baixos níveis de colágeno total, mas a proporção de colágeno tipo I é 

mais alta, bem como a expressão de TGF-β. O TGF-β estimula não somente a produção de 

colágeno, mas também a maturação do colágeno tipo III em colágeno tipo I,
26

 e essa 
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capacidade tem sido demonstrada na modulação da produção de matriz óssea, particularmente 

na ausência de inflamação.
27

 Estudos prévios sugerem que, em alguns tipos celulares 

(fibroblastos), o papel do TGF-β está mais fortemente associado à maturação óssea do 

colágeno do que a superprodução de colágeno.
15,18,22

 Se isso for verdade, então os fibroblastos  

de GP seriam diferentes dos fibroblastos de FOP?  

Fibroblastos, células presentes tanto em GP como em FOP, produzem TGF-β,
15

 

entretanto, a origem dessas células parece ser diferente nessas lesões. Os fibroblastos do 

ligamento periodontal produzem níveis mais elevados de osteoprotegerina (OPG) do que os 

fibroblastos gengivais.
28

 OPG é uma citocina que leva à maturação óssea, e, portanto, a 

origem desses fibroblastos pode ser diferente. Kumar e colaboradores
11

 sugeriram que os 

fibroblastos de FOP são originados do ligamento periodontal, e, assim, os fibroblastos de GP 

podem ser originados da gengiva ou do tecido conjuntivo, justificando localizações extra 

gengivais de GP.
1
 

Recentemente, Elanagei e colaboradores
29 

mostraram que, em contraste com o GP, 

as células na profundidade de FOP produzem osteopontina (OPN), uma proteína responsável 

pela deposição de matriz mineral em matriz orgânica
9
 na presença de TGF-β.

30
 Assim, esses 

achados suportam nossa hipótese de que as células de FOP são de origem diferente das células 

de GP.   

Em adição, nossos achados sugerem que o crescimento do FOP e sua maturação 

do colágeno dependem de TGF-β produzidos na superfície, mas durante longos períodos de 

tempo, há uma redução da sua produção na profundidade. Isso pode ser explicado pelo fato de 

haver uma redução da celularidade nos casos de FOP mais antigos. No geral, mostramos que, 

no FOP, a produção de colágeno é dependente de TGF-β, e a maturação do colágeno está 

diretamente relacionada à quantidade de colágeno. Em GP, nossos achados sugerem que a 

maturação do colágeno está diretamente associada ao tempo de evolução, apoiando a hipótese 

de maturação fibrosa de GP, como sugerido por Stablein e Silverglade.
1
 

Portanto, devido aos diferentes comportamentos de colagênese, propomos que GP 

e FOP tenham origem de fibroblastos distintos. Devido a ausência de inflamação e na 

presença de níveis elevados de TGF-β, há mineralização em FOP, mas não em GP. Entretanto, 

mais estudos são necessários para elucidar o papel das citocinas e proteínas ósseas no 

metabolismo dessas lesões.   
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